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For Users in the United States:

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user
is encouraged to try to correct the interference by one or more of the following measures:

Re-orient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

Use of a shielded cable is required to comply with the Class A limits of Part 15 of the
FCC Rules.

You are cautioned that any changes or modifications not expressly approved in this manual
could void your authority to operate and/or obtain warranty service for this equipment.

For Users in Canada:

This digital apparatus does not exceed the Class A limits for radio noise for digital
apparatus set out on the Radio Interference Regulations of the Canadian Department of
Communications.

Le present appareil numerique n'emet pas de bruits radioelectriques depassant les limites
applicables aux appareils numeriques de la class A prescrites dans le Reglement sur le
brouillage radioelectrique edicte par le ministere des Communications du Canada.
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Introduction 1
Thank You...

...for choosing the Digital Label and Decal Press. This press has been designed to
provide you with stunning, custom cut, high-quality color output on durable
adhesive-backed paper, vinyl, polyester, and even heat transfer material. It offers
many features which allow you to simultaneously print and cut professional-
quality labels, decals, signs, photos, and much more - quickly and easily!

A. HOW YOUR PRESS WORKS

This Digital Label and Decal Press utilizes two different, yet closely related
printing technologies to achieve its remarkable output - thermal transfer and 
dye-sublimation.

Thermal Transfer 
Thermal transfer is a process which uses a resin-based ribbon roll as a carrier for
transferring color to the print media (see Section 4 for more information on these
ribbons and the appropriate print media for each). Such ribbons are available in
single spot colors or in a paneled form which includes each of the yellow, magenta,
and cyan process colors on the same ribbon roll. By providing each of the process
colors, paneled ribbons allow you to conveniently produce full-color images
automatically, from a single ribbon.

As the ribbon and print media pass simultaneously beneath the press's print head,
thousands of thermal elements within the print head melt the colored inks, thus
transferring thousands of tiny colored dots from the ribbon onto the print media. If
using a paneled ribbon, the print media automatically makes a separate pass for
each colored panel on the ribbon. By combining different colored dots from each
ribbon panel in different combinations (this process is called "dithering"), the press
is able to print up to 16.7 million colors. 
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Dye-Sublimation

Dye-sublimation is similar to thermal transfer in that it still involves a paneled,
multi-pass process beneath the same thermal print head. The difference, however,
lies within the special dye-sublimation ribbon, the print media, and in the transfer
process itself. 

Unlike a thermal transfer ribbon, each colored panel on a dye-sublimation ribbon is
composed of colored dye rather than colored ink. When the dyes on the ribbon are
heated beneath the thermal Print head, they vaporize and diffuse into the surface of
the special dye-receptive print media. By varying the heat intensity of each thermal
element within the Print head, the press is able to change the value and hue of each
transferred dot of color. This results in the blending of one colored dot into the next,
producing continuous-tone, photo-realistic, color-accurate images with no dithering.

Digital Printing and Cutting… Simultaneously!

Your press has two prosessors, one that controls printing, and another that controls
cutting. It also has a memory buffer which stores commands allowing your press to
print and cut at the same time. 

The plotter-style drag knife cutter allows the press to cut any shape that can be
imported into our easy to use layout software. The cut line is treated just like a
graphic and can be edited to match any shape. The software can even trace around
an image to create a perfect contour cut.

B. SPECIAL FEATURES

With its dual function thermal transfer/dye-sublimation color printing capability,
this press offers you incredible printing versatility. The press's resin thermal transfer
mode prints outdoor-durable labels, signs, and decals on long-lasting vinyl or
polyester media. And with its dye-sublimation mode, this press delivers continuous-
tone, photo-quality output no other color printing technology can match.

Switching back and forth between these printing methods is easy. All you do is load
either the thermal transfer ribbon with the appropriate print media or the dye-
sublimation ribbon and print media, and select the appropriate printing choice from
within the press's software driver. The entire change-over process only takes just a
few minutes.

And, best of all, operation is simple and straight forward. This press will print from
any IBM-PC® or compatible running Windows™. This means that you can use
virtually any software application running under Windows to create your custom
labels or decals. Then, just import your design into PressPrint printing software to
duplicate, print, and cut as many labels as needed. 

To begin using your press, please refer to the remainder of this manual. The User's
Manual is your complete step-by-step guide to setting up and printing with your
powerful, new Digital Label and Decal Press.
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2
Before operating the unit, please read the following safety precautions carefully.

CAUTION!

TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THE UNIT
TO RAIN OR MOISTURE. TO REDUCE THE RISK OF ELECTRIC
SHOCK, DO NOT REMOVE FRONT, TOP, SIDE, OR REAR PANELS. NO
USER-SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED
SERVICE PERSONNEL.

WARNINGS
Operate the unit only on 110-120 VAC, 50/60 Hz, if operating within the United
States or Canada. For printers that have been shipped outside of the United
States and Canada, operate the unit only on 220-240 VAC, or 100 VAC in Japan.
If you have any doubt as to whether you have a unit with the correct voltage
rating for your country's power supply, DO NOT ATTEMPT TO USE THE
UNIT. Contact your dealer or the factory.
Stop operation immediately if any liquid or solid object should fall into the
cabinet. Unplug the unit and have it checked by qualified service personnel.
Do not disassemble the cabinet. Refer servicing only to qualified personnel. 
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A. CHOOSING A GOOD LOCATION

Place the unit in a location with adequate air circulation to prevent internal heat
build up. 

Use the dimensions specified in Section 10 as a guideline for the minimum
clearances to the unit.

NOTE: Allow for adequate clearance above the unit to accommodate the height of the unit with its
cover open.

Do not place the unit in a location where the ventilation holes located on the
left of the unit could become blocked.
Do not install unit near heat sources such as radiators or air ducts, or in a place
subject to direct sun-light, excessive dust, mechanical vibration or shock.

B. ABOUT MOISTURE CONDENSATION

If the unit is brought directly from a cold to a warm location, or is placed in a very
damp room, moisture may condense inside the unit. Should this occur, print
quality may not be optimum. Leave the unit turned off in a warm, dry room for
several hours before using. This will allow the moisture to evaporate.
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C. UNPACKING AND INSPECTION

Your Press 3 ships in two separate cartons, one for the printer, and one for the
Media Input Assembly and Media Output Tray. While unpacking your printer,
inspect the cartons to ensure that no damage has occurred during shipping. Make
sure that all supplied accessories are included with your unit. The following items
should be included:

Printer
Power Cord
USB Interface Cable
Media Supply Unwind Assembly
Media Output Tray
Ribbon Cartridge (1)
Cutter Blade Holder with Blade (1)
Printer Driver Software
PressPrint Label Software
PANTONE Software
Warranty Statement and Registration Card
This manual and other printed information

Save the carton and packing materials. They will come in handy when
transporting the unit.

D. IDENTIFYING THE PARTS

This illustration shows the features found on the front of your Press Digital Label
and Decal Press. 

Printer Hood

Printer Hood Release

Print Media 
Input Assembly

Print Media 
Roll Release

Cancel Button
Menu Button

Retry/Enter Button

Print Media 
Output Assembly

Cutter Hood

LCD Display

Control Panel
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Control Panel

Notice that Press's Control Panel LCD Display shows information on both cutting
and printing.  The reason for this is that each of these functions works
independently of each other. This means that if the print job is canceled, for
example, the cutter will continue to cut and vice- versa. The following describes
the function of each button as well as the information found on the LCD display:

LCD Display

This display is used to convey useful information to the user. The following table
shows some of the normal messages you will see during normal operation:

Message Description

POWER UP This is displayed during “boot up” sequence when
INITIALIZING power has been applied to the unit. During this 

sequence you will see helpful information on the
firmware version for both the cutter and the printer
displayed.

PRINTER: READY The press is ready to receive a job.
CUTTER: READY

#200 ABR (paper type) This useful message identifies the type of paper
QUANTITY: XXX installed as well as the number of prints remaining 
(number of prints) on the roll. Please refer to section 4-H for a 

description of paper types shown in this display

PAGE COUNT: XXXX This message displays the number of pages that 
(number of prints) have been printed since the press has been turned

on. This number can also be reset to "0". This is 
described later in this section.  

Table 3.1.  Normal Display Messages
More messages can be seen in Section 9: Troubleshooting.
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Cancel/-

The Cancel button cancels cutting and ejects the page. As a fail-safe, the Retry
button must first be pressed to pause cutting. When the Printer Hood is opened,
pressing Cancel will force the paper to reverse through the paper path. This is
useful in unloading the paper roll. The Cancel key also functions as "-" to step back
through previously displayed options when using the Menu feature of your press
as described below. When the Printer Hood is closed, press Cancel and Retry
simultaneously to reset the press's processors and clear its memory buffer.

Menu/+

The Menu/+ will open the menu options. The menus will allow you to load paper
and select some cutter settings. Once in the menu, this button performs the "+"
feature to advance through available options while Cancel/- allows you to display
the previous selection of the menu item. The following table describes the menu
items available on your press:

Menu Item Description

PAPER LOAD SEQ This will initialize a paper load sequence that cuts 
ENTER WHEN READY the leading edge of the sheet and positions the 

paper for printing. This is used when loading a new 
roll and is describe in detail in section 4-G.

PAGE COUNT: 0000 This will reset the PAGE COUNT feature (described 
ENTER TO ZERO on page 13) to 0.

TEST PRINT This will initiate a printer self test described in
ENTER WHEN READY detail in section 5-A

PAGE LOAD TEST This tests the paper path of the press and is 
ENTER WHEN READY described further in section 5-A

Table 3.2.  Menu Items in the Control Panel Display

NOTE: The Menu will automatically close if no button is pressed for a period of 10 seconds.

Retry/ Enter

The Retry button is used to continue press operation after an error has occurred.
For example, if your press runs out of ribbon, the machine will stop printing and
an OUT OF RIBBON error will be displayed on the LCD. Once a new ribbon has
been installed, you can press the Retry button to continue the job. The Enter
feature is used to select a choice in Menu mode as described above. When the
Printer Hood is open, pressing Retry will force-feed the media through the paper
path. With the Printer Hood closed, pressing Retry and Cancel simultaneously will
reset the press's processors and clear its memory buffer.
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Cutting Pressure

The Cutting Pressure slide adjusts the amount of pressure used by the press's
cutter. It is very important that this cut pressure be adjusted properly. If cut
pressure is too high, The press may cut all the way through the print media. This
will cause premature wear on the cutting blade and may even cause the cutter to
stall. If cut pressure is too low, the press may not cut deeply enough. This makes it
difficult to remove the matrix or "weed" the excess print media from the finished
labels. When optimum cut pressure is set, the press will cut completely through
the adhesive-backed portion of the print media and ever so slightly into the
backing.

When switching between the press's variety of print media, it will most likely be
necessary to adjust the cut pressure in order to accommodate the unique
characteristics of each media type. In most cases, optimum cut pressure can be
determined after just one sheet of media has been cut. If cutter adjustment is
required, the cut pressure can be adjusted at any time, even while print media is
being cut.

The default position of the Cutting Pressure slide is in the exact center. To increase
pressure, move the slide toward the positive (+) end. To decrease pressure, move
the slide toward the negative (-) end. A corresponding number value will be
displayed on the LCD when the slide switch is moved to allow you to easily note
the cutter pressure setting. Do not make extreme adjustments to the Cutting
Pressure slide. It is recommended increases or decreases to the cut pressure do not
exceed 5 units on the LCD (or 1 bar on the slide switch) at a time.

NOTE: An additional cut pressure adjustment option is provided within the PressPrint software.
This option should rarely need to be adjusted, however, since its optimum setting is preset
at the factory. See page 82 for more information on this option.
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This illustration shows the input ports found on the rear panel of the printer. When
connecting Press to your computer, you will use its Parallel Interface Port. For more
information on this port, please refer to Appendix A.

E. REMOVING THE RIBBON CARTRIDGE AND BLADE HOLDER

A single Ribbon Cartridge and Blade Holder are included with Press. The Ribbon
Cartridge holds print ribbons in place inside the printer. The Blade Holder holds
the cutter blade in place inside the cutter. For your convenience, the Blade Holder
ships with a blade already installed. During shipment, these items are fastened to
each other inside the unit. 

Power Switch Power Input Port Parrallel Interface

Media Input Assembly
Interface Cable

Impressa3.qxd  10/22/01  9:29 PM  Page 14



Section 3:  Getting Started 15

Digital Label Press 3 User’s Manual

Additional ribbon cartridges can be purchased to make switching between Press's
various print ribbons more convenient. Additional cutter blades can also be
purchased as needed. To remove these items from the inside of the printer, refer to
the following steps:

1. Press the Cover Release Button. Allow the cover to swing up and open.

2. With the cover open, you can see the Ribbon Cartridge.

3. Remove the shipping tape from both sides of the cartridge. Grasping each side
of the cartridge, lift it straight up and carefully remove it from the printer.

4. Remove the shipping tape fastening the Blade Holder to the Ribbon Cartridge
and separate the two items. Remove the Blade Holder from its packaging, and
refer to the next procedure for instructions on installing the Blade Holder into
Press's cutter.

THE CUTTER BLADE IS RAZOR-SHARP AND CAN EASILY CUT YOU. BE
EXTREMELY CAREFUL WHEN HANDLING THIS BLADE!

F. INSTALLING THE BLADE HOLDER

Refer to the following steps to install the Blade Holder into Press's cutter.

1. Open the Cutter Door by pulling up on the end of the cover closest to the paper
output tray.

2. Locate the black, plastic Cutter Arm. This is what holds the aluminum Blade
Holder in place.

CAUTION!

!

Blade Holder

Cutter Arm

Securing Knob
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3. Place the Blade Holder into the Cutter Arm and tighten the gold-colored
Securing Knob by turning it toward the front of the printer.  Tighten only until
the Blade Holder fits securely within the Cutter Arm.  To verify proper
tightness, try rotating the Blade Holder clockwise within the Cutter Arm.  If it
rotates, the Securing Knob needs to be further tightened.  Do not over-tighten!

G. INSTALLING THE MEDIA INPUT ASSEMBLY

Press's Media Input Assembly houses the supply roll of print meda and has
sensors that identify the type of material as well as the number of sheets remaining
on the roll. The Media Input Assembly connects to the press as follows:

1. Lock the Media Input Assembly in place on the left-hand side of the press. The
assembly has extensions on either side that engage securing notches on the
press.
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2. Connect the Media Input Assembly Interface Cable as shown.

H. INSTALLING THE MEDIA OUTPUT ASSEMBLY

Press's Media Output Tray consists of two separate stages. The lower portion of the
tray assembly protects media during the printing process. The upper portion of the
tray collects the finished sheets as they leave the press. The Media Output Tray
Assembly locks in place on the right hand side of the press. The assembly has
extensions on either side that engage securing notches on the press as shown
below.
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I. APPLYING POWER

1. Locate the power cord supplied with your press.

2. With the press's power switch turned off, place one end of the power cord into
the power port on the rear panel of the press.
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A. INTRODUCTION
As you may already know from reading Section 1, this press is able to produce a
variety of output by using a variety of different print ribbons. Each of these
ribbons is unique, and each requires its own compatible print media. To make it
easy for you to remember which ribbons are to be used with which print media
and which type of output each set of print supplies will produce, Press print
supplies are divided into two separate categories. These categories include #200-
Series supplies and #300-Series supplies. 

This section describes the ribbon and print media in each of these categories and
explains how to install these print supplies into your Press. 

B. ABOUT RIBBONS

#200-Series Ribbon - Dye-Sublimation Print Method
The #200-Series Ribbon utilizes what is called a dye-sublimation print method and
is distinguished by its GRAY cores. This ribbon is designed to print onto special
dye-receptive polyester label stock and produces durable labels and decals that are
color-accurate when used with the optional color matching software. 

This ribbon is in a convenient paneled format.  The panels include the three
process colors of yellow, magenta, and cyan as well as a clear overlay panel, which
makes printed images more durable. This means you can automatically print
continuous-tone process color images with no dithering. Due to its precise color
matching ability and its true photo-quality output, this ribbon is the most popular
of the Digital Label Press's print ribbons.

The #200-Series ribbon provides exactly 50 sheets worth of output and has a
maximum printable area of 11.71" x 17.3" (297 x 439mm). This ribbon can be used
only in conjunction with the special #200-Series dye-receptive polyester label stock
which is distinguished by a GRAY-and-WHITE package cover sheet (see Part E of
this section for more print media information).

Ribbon and
Print Media 4
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#300-Series Ribbons - Resin Thermal Transfer Print Method
#300-Series Ribbons utilize what is called a resin thermal print method and are
distinguished by their WHITE cores. These ribbons are designed to print onto vinyl
label stock and produce Press's most durable, longest lasting form of output. 

Resin ribbons are available in both a convenient 3-color paneled format and in a
variety of spot colors. The paneled ribbon allows you to automatically print full
process color images. The spot color ribbons allow you to print fast, one-color jobs.
Please note that process color output from the paneled ribbon will dither. Due to
the nature of resin inks, resin ribbons produce very durable output that can be
used in more challenging environments.

The #300-Series paneled ribbon provides 50 sheets worth of output while the spot
color ribbons produce up to 200 sheets. All resin ribbons have a maximum
printable area of 11.71" x 17.3" (297 x 439mm). These ribbons can be used only in
conjunction with the #300-Series vinyl label stock which is distinguished by a
BLACK-and-WHITE package cover sheet (see Part E of this section for more print
media information).

For current selection and availability on all Press ribbons, please contact your
nearest reseller.

C. LOADING RIBBON INTO THE RIBBON CARTRIDGE

Whether using the Ribbon Cartridge supplied with the press, or using other
cartridges purchased separately, all Ribbon Cartridges can be used with any of the
different print ribbons. Follow these steps to load a print ribbon into a Ribbon
Cartridge:

1. Remove the ribbon from its packaging. Do not touch the colored portion of the
ribbon. Oil or dirt from your hands can impair print quality. Handle the ribbon
only by the ends of its ribbon core.

2. The supply end of the ribbon is the end with the fresh, unused ribbon on it.
The take-up end of the ribbon is the other end. 

Take-Up

Supply
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3. Place the supply end of the ribbon into the supply end of the Ribbon Cartridge
as indicated. Make certain that the ribbon is fed from underneath the supply
end of the ribbon roll, up and over the top of the take-up end of the ribbon roll.

4. Once the ribbon is installed into the Ribbon Cartridge, it can then be placed
into the printer. See Part D of this section for instructions on inserting a loaded
Ribbon Cartridge into the printer.

D. PLACING THE RIBBON CARTRIDGE INTO THE PRINTER

1. Press the Cover Release Button. Allow the cover to swing up and open.

2. With the cover open, place the Ribbon Cartridge into the printer. Be certain that
the supply end of the Ribbon Cartridge is oriented towards the rear of the
printer.

3. Close the cover. When you start to print, the notches on the Ribbon Drive Hub
will automatically engage the take-up end of the ribbon.

NOTE: When the ribbon is installed properly, the black sensing plug in the supply end of the ribbon
roll should be located in the back, left-hand corner of Press's interior. This sensing plug tells
Press which type of ribbon is installed and MUST be present in order for Press to function.

Take-Up End

Supply End
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E. ABOUT PRINT MEDIA

#200-Series Polyester Label and Decal Stock
The #200-Series polyester stock is distinguished by a GRAY-and-WHITE package
cover sheet and, due to its unique composition, is the only polyester stock
compatible with the #200-Series dye-sublimation ribbon. The #200-Series stock is
available in white only, with a general purpose permanent adhesive ideal for
adhering to glass, metals, and some plastics. The sheet size of this print media is
12" x 20" (305 x 508mm), and it comes on a 100 sheet roll.

#300-Series Vinyl Label and Decal Stock
#300-Series vinyl stock is distinguished by a BLACK-and-WHITE package cover
sheet and is designed only for use with #300-Series ribbons. Together, the #300-
Series materials produce Press's most durable form of output suitable for more
challenging indoor/outdoor applications. 

Vinyl stock is used in a wide variety of applications where an economical yet
durable label or decal is required. Typical uses for vinyl materials include window
and door decals, automotive decals, outdoor signs, and more. Vinyl stock is
available in both a cast and a calendered form. Cast vinyl is very thin and
conforms easily to curves, over rivets, etc. Calendered vinyl is slightly thicker and
is used primarily on flat surfaces. Both types of vinyl provide a permanent
adhesive with a typical indoor/outdoor life of 3-5 years.

A clear cast vinyl is also available. This vinyl is perfect for window decals and
other transparent applications. All #300-Series vinyl stock has a sheet size of 12" x
20" (305 x 508mm) and comes on a 100 sheet roll.

#300-Series UL-Recognized Polyester Labels and Decals
A special #300-Series black ribbon is available for printing UL-recognized labels
and decals onto special white gloss, silver matte, brushed silver, or brushed gold
polyester stock. When used together, these materials can be used to produce rating
plates and other labels and decals requiring UL listings. These materials can also
be used for more general applications such as producing nameplates, faceplates,
and more. 

The UL ribbon provides 200 prints. The polyester stock has a sheet size of 12" x 20"
(305 x 508mm), is packaged in 100 sheet quantities, and has a general purpose
permanent adhesive. For best results, polyester stock should only be used with the
special black UL-recognized ribbon.
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NOTE: Although the #300-Series Black UL-Recognized Ribbon provides maximum printquality
when printing onto #300-Series Polyesters, you may also achieve acceptable results by
using the variety of other #300-Series Resin Ribbons with the polyester materials.  If doing
so, increase the Intensity setting within the printer driver setup window (see Section 6-D).
Note that print quality may vary when using the standard resin ribbons with the polyester
materials and, therefore, is not guaranteed.

IMPORTANT!  Always seal print media in its original packaging and place on a smooth, flat
surface when not in use. Do not stack objects on top of the print media or place
more than 500 sheets in a single stack. Print media must not be exposed to excess
dust, heat, direct sunlight, or moisture and must not be allowed to curl or bend.

F. LOADING THE PRINT MEDIA ROLL INTO THE PRESS

Your press uses media on a proprietary roll. The core of the media roll contains a
chip that stores important information which is displayed on the LCD panel. This
system allows the user to identify the type of media on the roll as well as the
number of prints remaining on the roll by simply looking at the LCD display
panel. 

Refer to the following steps to load print media into the supply tray:

1. Pull the Media Roll Release Lever downward.

Media Roll Release Lever
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2. Open the Media Input Assembly Cover.

3. Place the media spool on the supports located on either side of the Media Input
Assembly.

4. Close the Media Input Assembly cover.

Media Input 
Assembly Cover

Media Spool

Media Spool Supports
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5. Pull the Media Roll Release back into the "up" position This will lock the media
roll into place as well as engage the sensor that reads the roll's identification
information.  

6. Open the printer's Top Cover by pressing the Cover Release Button and remove
the ribbon cartridge.

Media Roll
Release Lever

Cover Release
Button
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7. Locate the Print Pressure Bracket indicated in the illustration below.  This
bracket runs the entire width of the printer's interior and must be removed in
order to load print media into the press.

8. The Print Pressure Bracket is held in place by two Securing Levers and is
connected to the printer electronically by its Sensor Connector.  Each of these
items is marked with a yellow colored end.  To remove the bracket, first turn
the printer power OFF, then disconnect the Sensor Connector by sliding it
toward the left-hand side of the printer until it stops.

9. Next, firmly pull up on each Securing Lever until each is in its fully opened
position as shown above.  Some force is required to unlatch these Securing
Levers. Note that lifting both the left and right Securing Levers simultaneously
may reduce the effort required to unlatch the levers.

Print Pressure
Bracket

Securing Lever
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10. Once the bracket is disconnected and unlatched, gently lift it from the printer.

11. Turn the Media Roll by hand to start the leading edge of the media into the
printer part of your press.  Inside the printer portion of the press you should
see the leading edge of paper start to enter the printing area.  
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12. Guide the paper over the Platen and under the Pinch Roller as shown.  Make
certain the paper is centered on the platen roller.

13. Remove any slack in the paper path by pulling on the leading edge of the
paper. Continue to feed the paper through the press until the leading edge can
be seen coming out the left side of the press. (Hint: Remove the Output Tray to
better see the paper path.
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NOTE: To ensure proper operation, the media MUST be centered on the platen roller! If after
normal operation your paper is not centered, adjust the media bias lever on the back of the
Media Input Assembly.

14. Making certain the paper is tight and centered in the press, insert the Print
Pressure Bracket back into its proper position inside the press. Be sure the Print
Pressure Bracket is seated properly on top of the Chassis Tab on each side of
the printer's interior as shown. 

Media Bias Lever

Print Pressure Bracket

Chassis Tab

???
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15. Once the Print Pressure Bracket is in the proper position, firmly push each
Securing Lever all the way down until each is in its locked position.  Some
force is required to latch these Securing Levers.

16. Reconnect the Sensor Connector by sliding it toward the right-hand side of the
printer until it stops.

IMPORTANT: The Sensor Connector must be in place for your press to function properly.

17. To cut the excess paper you must run the Paper Load Sequence from the
Control Panel Menu. Press the Menu button until the display reads:

Next, press the Enter button. The press will engage it's Rotary Cutter, slicing off the
excess media to ensure a squared edge. The press will then position the paper
up into the print area.  Your press is now ready to receive a job.

If you would like to test the paper path and make sure that everything is loading
correctly, there is a paper-loading test in the press's menu. Press the Menu button
repeatedly until the LCD Display reads:

Press Enter to start the test. The press will draw paper in, reverse it, then feed it up
into the cutter. It will then sheet the paper with its Rotary Cutter and eject the
blank 12" x 20" sheet into the output tray.
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G. PAPER AND RIBBON DESCRIPTIONS FOR THE CONTROL PANEL LCD 
DISPLAY

The following chart lists and describes the paper and ribbon types you will see
reported on the Control Panel LCD Display:

Ribbons:

Display Description

#300 SPOT #300 Series Resin Thermal single Color Ribbon

#300 3 COLOR #300 Series Rein Thermal CMY 3 Color Ribbon

#200 DYESUB #200 Series CMYO Dye-Sublimation Ribbon(3 color ribbon 
with protective overlay)

Paper:

Display Description

#200 ABR #200 Series Dye-sublimation Adhesive Backed Receiver

#300 CAL #300 Series Calandered Vinyl

#300 CAST #300 Series Cast Vinyl (white and clear)

#300 POLY #300 Series Polyester (brushed silver or brushed gold)

Table 4.1.  Paper and Ribbon Descriptions in the LCD Display
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A. RUNNING THE SELF TEST

Now that print supplies are installed and power is applied, a self-test should be
performed to check for proper operation of the printer. Press is capable of doing a
specific self test print for monochrome resin, 3-color resin, and dye-sublimation.
The following steps describe how to perform a self-test print:

1. Make sure the appropriate supplies are properly loaded, that power is ON, and
that the Top Cover and Cutter Door are shut.

2. Repeatedly press the "Menu" button on the control panel until the LCD reads:

3. Press the ENTER button on Press's Control Panel.

4. Press MENU again to cycle through the three types of self-tests. MONO RESIN
is the self test for #300 Series Monochrome ribbon and #300 Series Vinyl. 3
COLOR RESIN is the self test for the #300 Series 3-Color Paneled Resin Ribbon
and #300 Series Vinyl. 3 COLOR DYE SUB is the test for the #200 Series 3-
Color Paneled Dye Sublimation ribbon with the #200 Series Dye Sublimation
Adhesive Backed Receiver media. Once the proper section is displayed on the
LCD, press the Enter button. 

Connecting the Press 5
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5. The press will both print and cut the self test image. Please note that the print
quality of the self-test may not be optimum. Don't worry, this is perfectly
normal. The self-test procedure is not intended to demonstrate print quality,
but rather to verify that the unit is mechanically sound.

Self Test Example
(Approximately 30% of actual size)
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B. CONNECTING THE USB-TO-PARALLEL INTERFACE CABLE

This press is designed to be used with nearly any high-end IBM-PC or compatible
running Windows 98, ME, and 2000. For best performance, a minimum of a
Pentium III/IV with 128 megabytes of RAM or higher and a hard disk with at least
2 gigabytes of free space is recommended. Note that processing speed will increase
if additional RAM is added.

The printer is equipped with a USB to parallel adapter cable. This cable provides
the extremely high data transfer speeds required to send files to your press. 

1. Connect the USB cable to your USB port. The other end of the cable should not
be connected to the printer. 

2. Your computer will automatically detect the cable as a plug and play device.
You may be prompted to find a driver for the cable. If so, simply place the
driver disc for the cable in your CD-R drive and click Next. 
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3. Select Search for the best driver for your device (Recommended). And click
Next.

4. Select CD-ROM Drive and click Next.
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5. Click Finish. Once the driver for your USB cable is installed, connect the other
end of the cable to the parallel interface port located on behind the press.

The Control Panel LCD must display, "PRINTER READY CUTTER READY" in
order to receive data. 

IMPORTANT! In order to begin printing with this press, you must first install its custom  printer
driver software along with the PressPrint software for Windows. For instructions
on installing and using this software, please refer to Section 7 of this manual.

Impressa3.qxd  10/22/01  9:29 PM  Page 37



38 Section 5:  Connecting the Press

Digital Label Press 3 User’s Manual

Impressa3.qxd  10/22/01  9:29 PM  Page 38



Section 6:  Installing and Setting Up the Printer Driver for Windows 39

Digital Label Press 3 User’s Manual

A. INSTALLING THE WINDOWS PRINTER DRIVER

Before you can print, you must first install the printer driver. The printer driver is
simply software which gives the press the proper commands it needs in order to
print. Use the following steps to install the printer driver into Windows. Once the
driver is installed, put it away in a safe place in case it ever needs to be reinstalled.

NOTE: This section of the Operator's Manual assumes that you are already familiar with Windows
and know how it operates. If you are not yet familiar with Windows, consult the appropriate
Microsoft® documentation to become familiar with the basics of Windows before
proceeding.

1. Insert the Software Installer Disc into your computer's CD-ROM drive.

2. Click the Start button, point to Settings, and select Printers.

Installing and Setting
Up the Printer Driver 

for Windows 6
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3. Double-click on the Add Printer icon.

4. You will enter the Add Printer Wizard. This will program will aid you in
installing your printer driver. Click Next to continue

5. You will be asked if this is a Local Printer or a Network Printer. Select Local
Printer and click Next to continue.

6. The next window will ask you to select the type of printer you wish to install.
The Digital Label Press 3 is not one included on the list of printer. Click Have
Disk to locate the files you wish to install.

40 Section 6:  Installing and Setting Up the Printer Driver for Windows
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7. Now you will be prompted to locate the driver. Click Browse to locate the files. 

8. The Browse window will now appear. In the Drives: drop-down window,
select your CD-ROM drive that contains the Digital Label Press 3 Software
Installer Disc. In the Folders: window, double click on the Drivers folder, then
double click on the Windows 98-ME folder if you are installing the driver on
Windows Windows '98, or Windows ME. Double click on the Windows 2000
folder if you are installing the driver on Windows 2000.

NOTE: Your CD-ROM drive is most likely D: or E: and is identifiable by the CD icon next to the
drive letter.

9. Once you have selected the folder, you will see PRESS.INF appear in the File
name: window. Click OK.

10. The Install From Disk message will appear. Click OK to continue.
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11. Follow the on-screen instructions to complete installation. When prompted, do
not have Windows print a test print, since you most likely performed a printer
self test in Section 5. Once installed, the Digital Label Press 3 icon, shown
below, will appear in the Printers folder. 

B. SETTING UP THE WINDOWS 98/ ME PRINTER DRIVER

Once the printer driver has been successfully installed, you will need to set the
driver up with the appropriate print options for your specific print job. Refer to the
following steps to change or verify your printer driver options.

1. Click the Start button, point to Settings, and select Printers. Then, click on the
Digital Label Press 3 icon with the right mouse button and select Properties.
The Properties window will appear.

2. Click on the Details tab of the Properties window. Be sure to set the option
Print to the following port: to LPT10 Belkin USB, then click Apply to save the
option. 

3. To see the driver options, select the Setup button. 

NOTE: The PressPrint printing software allows you to change these same printer driver options
through the Printer Setup button of the Print window. This means that you don't have to
go back to the main printer setup window each time you want to change a setting or option
in the printer driver.
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4. The Digital Label Press 3 Setup screen appears. Change the options as follows:

Paper Size
Press prints onto oversized Super B/A3-size print media. Super B/A3-size media
has a 12" x 20" (305 x 508mm) sheet size which provides a maximum printable area
of 11.71" x 17.3" (297 x 439mm). This means Press can print nearly the entire width
of a sheet, but that it requires a non-printable margin of about 1.5" (38mm) on the
top of the sheet and about 1.2" (30.5mm) on the bottom.

When printing from PressPrint, note that the default Blank Size is already set to
Press's maximum printable area of 11.71" x 17.3" (297 x 439mm). For best results,
leave the Blank Size set to these dimensions.

Ribbon Type
Click on the Ribbon Type down arrow. The following ribbon selections will appear:
Spot Color Resin (#300-Series), Process 3 Color Resin (#300-Series), and Process
3 Color Dye-Sub (#200-Series). Select the ribbon type option that's appropriate for
the type of ribbon you are using. See Sections 4-B, 4-E, and 4-F for a complete
description of all available ribbon types.

Color Matching 
Click on the Color Matching down arrow and select the appropriate color
matching option. Select None if you are more interested in print speed rather than
print color, if you have already color corrected your image for printing, or if you
are using Press's PANTONE Color Matching Software. 
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Select Algebraic if you would like the printer driver to make very simple, yet fast,
color balance adjustments. This option gives you more natural looking images
without actually utilizing any specific color matching software and without
slowing down the processing speed of the printer driver. In general, this option
works best when printing full-color graphics with the process 3 color resin ribbon.

The PrimaColor option automatically adjusts the color of your image according to
preconfigured printer profiles and default system profiles. This results in a very
precise color match compliant with ICC standards.

NOTE: The PrimaColor option is intended to match color hues as closely as possible. This means it
works best when printing photographic images. When printing simple spot colors, you may
notice that some colors may appear slightly muted.

Since the default system profiles provided are generic, the colors of some monitors
may still vary slightly from your output. As a solution, raw printer profiles are
included in case you would like to combine your custom monitor profiles with the
printer profiles. This can be done through third-party color matching utility
programs.

Dither Mode 
This option only applies when printing with a resin (#300-Series) ribbon type.
Click on the Dither Mode down arrow and select the appropriate dither option.
Selecting Fine Dither provides a print in which the dots of color are very close
together, giving you increased clarity if the image is to be viewed up close.
Selecting Coarse Dither provides a print where the dots are slightly larger and
spaced further apart. This is a good option to select if you are printing images
which may be viewed from further away. The Coarse option is also effective in
hiding print imperfections if you are working in a particularly dusty environment.

Intensity
This control sets the lightness or darkness of the printed image. Click and drag on
the slider bar or click on the left and right arrows to change the amount of heat
used in the printing process.

Disable Overlay
This option only applies when printing with the 3-Color Dye-Sublimation (#200-
Series) ribbon type. Select this option if you wish to print dye-sublimation output
without applying the ribbon's clear overlay panel. Please note that image
durability will be minimal if this overlay is not applied. 

Enhance Fine Text
This option only printing with a dye-sublimation (#200-Series) ribbon type. When
selected, this option allows the unit to apply the software-based spatial filter of
PRIMERA's RasterText™ technology. This filter brings out the fine detail of smaller
text and lines and allows them to print with much greater definition and clarity.
Image processing time will increase when using this option.
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Write Direct to Port
Select this option if you wish to bypass Windows Print Spooler. It is recommended
you do not use this unless you are having difficulty printing through the Windows
Print Spooler.

Disable Target & Cut
Select this option if you wish to bypass the cut function and use only its print
function. This can be helpful if, for example, you are printing a large-format sign
or photo that does not require precision cutting.

Cut Only (Disable Print)
Select this option if you wish to bypass the print function and use only its cut
function. When the No Targets option is selected, the press operates similar to a
traditional cutter in that it is able to cut shapes and letters out of completely blank
label stock. 

Orientation
Select either Portrait or Landscape.  Selecting Portrait causes the page to print in a
vertical orientation.  Selecting Landscape causes the page to print in a horizontal
orientation.  An icon illustrating a printed page in the dialog box helps you
remember the difference between the two.

Calibrate
This option allows you to recalibrate your printer's ribbon sensor if the need
should ever arise. For more information on the printer's ribbon sensor and on the
calibration process, please refer to the end of Section 9. In most instances, this
calibration procedure should not be necessary. 

Select OK again to return to the Printers window. Exit this window and you're
ready to go on to Section 7. All printer driver options you selected will stay the
same until you change them.
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A. ABOUT PRESSPRINT

PressPrint for Windows is a software application program specifically designed for
use with your press.  This program is required in order for the press to both print
and cut images.  

PressPrint is primarily intended to be used as a type of print utility program in
which images created through other software applications can be imported,
contoured for cutting, duplicated, and sent to the press for production.  It does,
however, include a variety of extra tools and menu selections in order to allow you
to create more simple label and decal designs directly.

This section will guide you through the installation process and will also explain
how to efficiently use PressPrint in its primary role of mass producing pre-
designed images.  For details on PressPrint's more general capabilities, tools, and
menu selections, please refer to its extensive on-line Help menu.

B. INSTALLING PRESSPRINT

PressPrint installs just like any other standard Windows application program.  To
install PressPrint, simply close down all other programs and insert the software
installer disc into your computer's CD drive.  PressPrint's Installer Program will
automatically open.  Follow the on-screen instructions to complete installation.
Note that when the installer program displays the Font Installer dialog box, select
the Continue button to load all of your current system fonts into PressPrint.  This
is necessary in order for PressPrint to recognize your system fonts. 

Installing and Using
the PressPrint

Software for Windows 7
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Once installed, the PressPrint icon, shown below, will appear in the Programs
group of the Start menu.  Select the PressPrint icon to open PressPrint.

If PressPrint's Installer Program does not automatically open when the CD is
inserted into your computer's CD drive, refer to the following steps to install
PressPrint:

1. Double click My Computer, then double click on the CD-ROM drive
containing the Digital Label and Decal Press 3 software installer disc.

2. Double click the Setup.exe file.

3. Follow the on-screen instructions to complete installation. Once installed, the
PressPrint folder will appear in the Programs group of the Start menu. Select
the PressPrint icon to open PressPrint.

C. USING PRESSPRINT

This part of Section 7 explains how to use the PressPrint features most essential to
printing.  Refer to the following steps to learn how to import an image, place a
contour cut line around it, and duplicate the image down and across the page.

1. After opening PressPrint, select Import from the File menu.  The Import File
window appears.

2. Select the file you would like to import.  To do this, use the list of File Type
options to select the exact type of file you would like to import. Then, use the
Look in: box to navigate to the drive and directory in which your file is
located.  Select the specific file you wish to import.  (Select the Merge check
box if you intend to import two or more different images onto the same page.)
Click on OK to begin importing.  (See Part F of this section for tips on
importing different file types.)
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3. When the file is finished importing, it will automatically be selected. Click and
drag on the surrounding nubs to resize the image. Click and drag on the center
nub to move the image. Note that for best print quality, imported bitmap
images should be kept at or close to their original size.

4. While the image is still selected, click on the Cut menu and select Contour Cut
(see Part F of this section for information on PressPrint's Die Cut feature). The
Contour Cut Settings window appears. 

5. Select         to trace a cut line along the exact contour of your image's outside
edge.  Select          to trace a cut line along the contour of both the outside and
inside edges of your image. In this case, the software will essentially attempt to
cut away anything it sees as white space. Then, enter the desired Offset value
colored portion of your image. Entering a value greater than 0 will cause the
cut line to be placed away from the colored portion of your image. Entering a
value less than 0 will cause the cut line to be placed within the colored portion
of your image. Entering an exact value of 0 will cause the cut line to be placed
on the very edge of where the colored portion of your image meets white
space.
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6. Select OK to begin contouring your image.  You may see the following dialog
box appear when attempting to contour cut bitmap files. This slide bar sets the
sensitivity of the filter. If your sensitivity is high (i.e. 255) your cut line may
appear jagged as the filter picks up "noise" around the outside of an image.
This is common in lower resolution files as well as JPEGs. If the sensitivity is
too low (i.e. 100) the cut line may not follow the image and could overlap light
colored areas. A good general setting is 240.

7. Select OK to begin contouring your image. This process will take from just a
few seconds to a few minutes depending on the size and complexity of your
image.  When the image is finished contouring, a dashed cut line will appear
around your image and both will be selected. 

NOTE: If you imported a bitmap image, you may wish to select Show Bitmaps Outlines from the
View menu before proceeding. For more information on this option, see its explanation in
Part F of this section.
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8. With both the cut line and the image selected, click on the Layout menu and
select Array.  The Array Setup window appears.

9. Enter the total number of copies you would like to make of your image.  Adjust
the margins and/or spacing between each image accordingly in order to fit the
maximum number of copies on each page.  The Page Preview shows you how
your images will layout when duplicated.  The Total Number of Pages box
shows you how many individual pages will be required to produce the
specified number of labels.

10. Click on OK to begin duplicating your image.  Note that if copying multiple
pages of output, only one page of images will actually appear on screen.  This
is done to conserve system resources.  PressPrint remembers the total number
of pages created, however, and automatically sends them to the press at the
time of printing.

When your image is finished duplicating, you may wish to save your file before
printing.  To do this, select Save from the File menu and specify a file name and a
location of where you would like the file to be saved.  Files will be saved with
PressPrint's native ".CDL" file extension.
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D. PRINTING TO YOUR PRESS

Once you have successfully completed Part D of this section, you can then send
your file to be printed and cut.  Refer to the following steps to begin printing.

1. Select Print from the File menu.  The Print window appears.

2. Be sure Digital Label Press 3 is selected under the Printer option.  The rest of
the options can be left at their default settings for most print jobs.  Notice that
the number in the Copies box will automatically match the total number of
pages specified when you originally arrayed your image.

NOTE: If you intend to print with the #200-Series dye-sublimation print supplies, you may wish
to select one of the Anti-Aliasing options from the Preferences tab.  Anti-Aliasing causes
printed images to appear more smoothly around the edges.  In most cases, the Fine Anti-
Aliasing option provides the best print quality.  DO NOT select anti-aliasing if printing
with #100 or #300-Series supplies, as it can actually degrade print quality with these
materials.

3. Click on the Printer Setup button.  The Digital Label Press 3 Setup window
appears.  Be sure that the appropriate printer driver settings are selected for
your upcoming print job.  In particular, be sure that the proper Ribbon Type
option is selected and that the Fast 32-bit Spooler option is checked.  Refer to
Section 6-D for more information on any of these printer driver options.

52 Section 7:  Installing and Using the PressPrint Software for Windows

Digital Label Press 3 User’s Manual

Impressa3.qxd  10/22/01  9:29 PM  Page 52



4. Once all appropriate printer settings have been chosen, select OK to close the
setup window.  Select OK from the Printing window to send your print job to
the press.

Before printing actually starts, the print job must be processed or rasterized.  This
will take anywhere from several seconds to several minutes depending on the
complexity of your image and the speed of your computer.  Your computer will not
be able to perform any other task while it is processing your job.   Once the print
job finished rasterizing, your computer will release the job, and you will hear the
press begin to feed the first sheet of print media. 

Your press will simultaneously print and cut as many sheets of output as you
originally specified.  While printing, you may wish to bring the 32-Bit Spooler to
the foreground in order to monitor the status of the print job.  If you experience an
error during printing, you can use the 32-Bit Print Spooler to pause the print job
while you clear any recoverable errors such as an initial print media or ribbon jam.
Once the error is cleared, select Resume in the spooler to resume printing.  After a
minute or two, the press will once again begin printing your print job.  

If you need to adjust the cut pressure during the print job, use the Cutting Pressure
slide on Control Panel.  See Section 3-D for information on when and how to adjust
the Cutting Pressure slide.  For more information on dealing with possible print
errors, please refer to Section 9.  For important hints on efficiently working with
the PressPrint software, please refer to Part F of this section.
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E. HELPFUL PRESSPRINT HINTS 

Importing Files
PressPrint accepts a wide variety of file types.  These file types are listed and
can be selected through PressPrint's Import window.  When importing files
created through other programs, be sure the file you are importing is one of the
file types listed in the import window.  Like all other graphics programs,
PressPrint will not be able to import an unsupported file type. 
If you have problems importing a certain file type, simply resave or export
your file as one of PressPrint's other supported file types.  In most cases,
importing a file which has been converted to a TIFF or JPEG will essentially
guarantee that PressPrint will accept it.  Most graphics applications allow you
to save or export images in a variety of industry-standard file types.  (If
importing TIFF files, note that only RGB TIFF images are supported.  CMYK
TIFF files will not import properly.)
When preparing a file to be imported, be sure to prepare and import a single
image only.  In other words, use PressPrint to duplicate and mass produce the
image after it has been imported.  

Importing Macintosh Files
In many cases, files which have been created on a Macintosh will need to be
imported into PressPrint.  This is done in the exact same fashion as importing a
Windows file and all the tips given in the previous "Importing Files" hint still
apply.  In addition, however, Mac users should be aware of a few additional tips.

Since you will not always have all of the fonts supported by a Macintosh on
your PC, you should always convert Macintosh text to curves before exporting.
This will turn fonts into graphics, thereby eliminating the need to support that
font on the computer running PressPrint.
When exporting the image from your Macintosh program, be sure to export as
one of PressPrint's supported file types.  If you have trouble importing any of
the standard Macintosh file types such as an EPS, try exporting the image in a
bitmap format such as TIFF or JPEG.  These file types are standard to both Mac
and Windows. 
Be sure to name your file with the appropriate file extension to indicate the
type of file you are saving it as.  For example, if exporting your image as an
EPS file it should named "Filename.eps".  For a TIFF file, name it "Filename.tif".
Or, for a JPEG file, call it "Filename.jpg".
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Importing Vector vs. Bitmap Files
A vector-based file is a file such as an EPS which can be grouped, ungrouped, and
broken apart into a number of separate objects.  These objects can be individually
sized, deleted, or repositioned.  Vector files are generally created in programs such
as Adobe® Illustrator® or Corel Draw™ and are beneficial in that they can be
edited and greatly enlarged or reduced within PressPrint without sacrificing any
image quality or resolution.  

The draw back is that vector files include graphics only.  So, if you have a
photographic image within your label design, the photo will not be considered a
vector object and may not import into PressPrint along with the rest of the vector-
based graphics.  To overcome this issue, you can import the vector-based graphics
and the photographic image separately, then basically reassemble your label
design within PressPrint.  An easier way, however, is to simply import such a label
design as a bitmap file format.  

A bitmap file is a file such as a TIFF or JPEG which cannot be broken apart into
separate objects.  Instead, when an image is saved or exported in a bitmap format,
it becomes a single, solid object.  A bitmap file is beneficial in that it provides an
easy way to import nearly any type of label design from nearly any type of
program, without losing any of the label's design elements.  The only draw back to
bitmap images, however, is that they cannot be easily edited like a vector-based
image, and will slightly degrade in quality if significantly enlarged.

Show Bitmaps Outlines / Show Reduced Bitmaps
Since bitmap images are saved as one solid object, they tend to have a file size
slightly larger than that of a vector-based graphic.  This means that more system
resources may be required by such files causing your computer to slow down.  To
avoid this, PressPrint provides two options called "Show Bitmaps Outlines" and
"Show Reduced Bitmaps" under the View menu.  The Show Bitmaps Outlines
option makes bitmaps appear as a simple box outline on screen.  This conserves
system resources and greatly increases the speed of your system when working
with bitmaps.  The Show Reduced Bitmaps option conserves slightly less system
resources, but allows bitmaps to remain on screen by displaying them at a reduced
resolution.    

To utilize either of these options, simply import your bitmap label design and place
a cut line around it as usual.  Then, before duplicating the image, click on the View
menu and select either Show Bitmaps Outlines or Show Reduced Bitmaps.  All
bitmaps will be displayed accordingly as long as either option is selected.  To
return to normal display mode, simply deselect the option.

Purge Undo
Another option which will enhance the speed of PressPrint is the Purge Undo
option of the Edit menu.  Selecting this option from time to time will clear the
memory of PressPrint's Undo feature, thereby freeing up more memory for
PressPrint's more immediate functions.  Note that once the undo memory has been
purged, you will not be able to undo any actions done prior to the purge.
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Aligning Objects
PressPrint provides an alignment option which automatically aligns two or more
selected objects.  This feature is helpful if, for example, you would like to align a
Die Cut line with your label design or to align a selection of grouped label designs
to the page blank.  To utilize this feature, select the objects you wish to align.
Then, select Alignment from the Layout menu, specify how you would like the
selected objects to align, and click on OK.

Creating A Die Cut
A die cut is different from a contour cut in that die cuts provide a preset cut line in
shapes such as rectangles, circles, stars, ovals, etc.  PressPrint provides several die
cut shapes which can be individually customized.  To create a die cut line, select
the object around which you would like to place the cut line.  Then, select Die Cut
from the Cut menu.  When the Die Cut Settings window appears, specify the style,
size, and other custom settings of the cut line, and click on OK.  The die cut line
will automatically center in relation to the selected object.

Selecting Objects
To select an object, choose the Pointer tool and click on the edge of the object.  To
select multiple objects, hold down the shift key while clicking on the edge of each
object.  Another way to select one or more objects is to use the Pointer tool to click
and drag around the object or objects you would like to select.  As you drag the
pointer tool, a blue outline will appear.  Any object within this outline will be
selected.

Rotating Images to Maximize Space
In order to fit as many labels on a page as possible, you may sometimes wish to
rotate images so they can be placed closer together.  To rotate an image, select both
the image and its cut line.  Then, select Rotate from the Layout menu.  The Rotate
window appears. 

Enter the number of degrees you wish to rotate the image and click on the Apply
button. This will rotate the image. To close the Rotate window, click on the
button. 
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Use the Rotate option along with the Duplicate option of the Edit menu to create a
single row of closely placed images.  Use the Alignment option of the Layout
menu to help align the images.  Once you have a complete row created and
aligned (as shown below), click and drag the pointer around the entire row to
select it.  You can then use the Array option of the Layout menu to duplicate the
row down the page as you normally would a single image.

Anti-Aliasing
Anti-Aliasing is an option found in the Preferences tab of the Print window.  When
selected, this option automatically smoothes the edges of images printed with the
#200-Series dye-sublimation materials.  None, Coarse, Medium, and Fine anti-
aliasing options are available.  In general, the Fine option provides the best quality.
DO NOT select this option if printing with the #100-Series wax/resin or #300-
Series resin materials.  Since these materials cannot produce continuous-tone
images like dye-sublimation materials, anti-aliasing can actually degrade the
quality of resin and wax/resin images.

Printing Multiple Pages of the Same Label
Besides the standard method described in Part D (step 7) of this section, there is
another, sometimes more efficient, way of printing multiple pages of the same
labels.  To use this alternate method, simply import an image and duplicate one
page worth of labels.  Then, send that single page to the printer with the 32-Bit
Print Spooler's Save last job for reprint option selected.  After the first page is
finished printing, open the 32-Bit Spooler and select the Print button.  When the
Number of Copies to Print window appears, enter the number of pages you would
like to print, and click on OK.  All specified pages will then be printed.  The saved
print job will remain in the 32-Bit Print Spooler until another print job is sent to the
spooler and saved over it.
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F. CREATING SERIALIZED LABELS

PressPrint makes it easy to create serialized labels such as product serial tags,
parking stickers, and more.  PressPrint even allows you to incorporate text (.txt)
files, such as a list of names, into serialized labels for even greater customization.
To create a set of serialized labels, please refer to the following procedure.  As an
example, this procedure demonstrates how to create labels with both a serialized
number and a custom serialized name.  If you have not yet read through Parts D,
E, and F of this section, please do so before attempting to complete this procedure.

1. Import or create a label design in which you would like to place your serialized
text.

2. Use the text tool       to enter the line or lines of text exactly as you would like it
to appear in the first label. Enter a separate line of text for each text field you
would like to serialize.

3. Once you have entered the text, place a cut line around the entire label. Be sure
to select all items by clicking Select All from the Edit menu.
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4. With both the cut line and the label selected, choose Badges from the Layout
menu. The Badge Setup window appears.

5. Enter the number of labels you wish to create into the Number of copies box,
and adjust the vertical and horizontal spacing between labels as needed.  

6. Highlight the text you wish to have serialized and, if applicable, click on the
Browse button to select the appropriate Replacement data file.  The
replacement data file specifies the ASCI text (i.e. *.txt, *.csv) file you would like
to use in your serialized labels.  Such a file can be created in any text editing
program, such as the Notepad program in the Windows Accessories folder, and
saved in an MS-DOS Text (.txt) format. Files with multiple fields can be saved
as comma, tab, or space delimited files. When creating such a file, place each
item in the list on its own line, and be sure to close the file before attempting to
merge it into PressPrint.  A sample of the list created for this example
procedure is shown below:
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7. Once you have highlighted the text you wish to serialize and/or selected the
replacement data file, click on the OK button of the Badge Setup window.   The
Text Substitution window appears.   

8. When the Text Substitution window appears, make sure the text from the
replacement data file is listed under the appropriate column.  If not, use the
indicated "F" keys to cut and paste the data into the appropriate column.

9. Click on the top gray cell of the numerical text as indicated to select all of the
cells.  Then, enter the serialized text into the Edit Text box exactly as you would
like that text to appear on your first label, and click on the Serialization button.
The Serialize window appears.
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10. Highlight only the part of the text you wish to serialize. This is helpful when
serializing barcodes as you may have information that stays the same on each
label. Once this is highlighted, click Set Base. This tells the software the
number to start counting from when serializing. Next, enter the amount you
wish to increment each number. In the Type box you can select Character if you
wish the increment a letter instead of a number. Click OK to begin serializing
your labels. 

Note that if copying multiple pages of output, only one page of images will
actually appear on screen. This is done to conserve system resources. If you would
like to view subsequent pages, PressPrint does provide a scrolling tool                in
the bottom right-hand corner of its screen. This allows you to easily move from
page to page. When your labels are finished duplicating, you can then print them
according to the instructions in Part E of this section.

G. PRINTING MULTIPLE SPOT COLOR LABELS

Multiple spot color labels are labels created by using two or more of the press's
separate spot color resin or wax/resin ribbons to print a label design with two or
more separate colors.  This process is done by manually changing ribbon colors
during the print job and is beneficial if you would like to create a simple two or
three color label with no dithering.  Since separate ribbons are used, keep in mind
that the alignment of the different colors may not be exact.  For this reason, your
multiple spot color label designs should be relatively simple.
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The following is an example of how to print a multiple spot color job.  You may
want to actually complete this exercise as a self-tutorial.  If you do not have the
ribbon colors specified in this exercise, simply substitute any other spot color
combination.  Note that both single and multiple pages of multiple spot color
labels can be printed in this fashion.  If you have not yet read through Parts D, E,
and F of this section, please do so before attempting to complete this exercise.

1. Create a label consisting of a RED square background with BLACK text
centered inside.  Then, place a cut line around the red square and array the
labels down the page.  

2. Click on the RED color box in the color palette on the bottom of your screen,
and drag it to the first position in the palette (P1).  Likewise, click and drag the
BLACK color box to the second position (P2).  The Colors in the image will be
printed in the order in which they appear in the color palette.

3. Insert the RED ribbon into the printer and be sure the appropriate print media
is also loaded.  Then, select Print from the File menu.
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4. Select the appropriate Printer Setup options (Ribbon Type, etc.).  Then, select
the option Hold Media after Print (Don't Eject).  This will keep the media from
cutting the page before all the colors have been printed.

5. Click on the Preferences Tab and select the Separate Colors option.  This forces
the colors in your image to be printed separately.  Also, select the Clip
Separated Colors option if you do not want the press to print in areas where
the second color will be printed.  This option is useful if printing lighter colors
on top of darker colors.  Note that these options should only be selected when
printing multiple spot color print jobs.
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6. Click on OK to print.  PressPrint will send only the RED squares to be printed.
During printing, a message will display on screen telling you to wait until
printing is complete before loading the next ribbon color and reloading the
print media.

7. When the RED squares are finished printing, the printed sheet will be ejected.
At this time, remove the RED ribbon and load the BLACK ribbon.  Then, select
Print from the file menu and enter the Print Setup. This time disable the Hold
Media after Print option.

8. When all supplies are once again in place, click on OK.  PressPrint will send the
BLACK text to be printed.  The cutter targets and cut information will also be
sent at this time since black is the final color (PressPrint does this automatically
when the Separate Colors option is selected, as long as cutting is enabled in the
driver).  Printing and cutting of your two color labels should now be complete.
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Your press is built to require a minimum amount of maintenance. Nevertheless,
there are a few procedures you can perform on a regular basis or as needed to
ensure the best possible performance.

A. SUPPLIES REQUIRED

For the procedures listed in this section, you will need the following items:

Isopropyl alcohol
Soft, lint-free cloth
Small vacuum cleaner (if available)

Or, to make these maintenance procedures more convenient, a Printer Cleaning
Kit is available from PRIMERA or your authorized reseller. This optional kit
includes the following: 

Print head Cleaning Pens pre-moistened with 99.99% isopropyl alcohol for
cleaning your printer's Print head.
Cleaning Pads pre-moistened with 99.99% isopropyl alcohol for cleaning
your printer's rollers and general inside area.

B. CLEANING THE PRINT HEAD

This procedure is performed if you notice a streak running the length of the
page where ink was not transferred. This procedure should also be performed
approximately every 100 prints in order to maintain consistent print quality.

1. Turn the printer power OFF.

2. Open the printer's Top Cover by pressing the Cover Release Button.
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3. Remove the Ribbon Cartridge from the printer. 

4. Using a Print head Cleaning Pen from the Printer Cleaning Kit or a soft, lint-
free cloth slightly moistened with isopropyl alcohol, firmly wipe back and forth
across the surface of the Print head. If using a cloth, be extremely careful not to
use too much alcohol. It must not be allowed to drip into the printer!

5. Allow the Print head to thoroughly dry before re-installing the Ribbon
Cartridge.

6. Re-install the Ribbon Cartridge, and shut the cover. If a streak persists, Contact
PRIMERA Technical Support for further assistance (see Section 9 for Technical
Support information).

IMPORTANT! Never use a sharp tool or a metal object of any kind to clean the Print head. You
will damage the Print head!

C. CLEANING THE PRESS'S CASE

Your press has a durable casing that should retain its luster and appearance for
many years. Clean it only with a soft cloth slightly moistened with water or a mild
soap. Do not use excess water or cleaning solvents of any kind. Never spray the
cabinet with a cleaner. Rather, spray the cloth first and then wipe down the printer.

D. CLEANING THE INSIDE OF THE PRESS

As you use your press, dust and other particles will accumulate inside the printer's
case. These particles are attracted to the underside of the ribbon by static produced
during printing and can cause voids or colored spots on the printed image. Use the
following procedure to clean the inside of the printer periodically or as needed.

1. Open the printer's Top Cover by pressing the Cover Release Button.

2. Remove the Ribbon Cartridge from the printer.

3. Open the Cutter Door by pulling down on the door's handle.

4. If you have access to a very small vacuum cleaner (most computer stores sell
devices just for this purpose), use it to vacuum out all visible areas inside the
printer and cutter. Using such a vacuum works especially well when cleaning
paper dust from the cutter.

5. If you do not have access to a small vacuum, use a Cleaning Pad from the
Printer Cleaning Kit or a soft, lint-free cloth slightly moistened with isopropyl
alcohol to wipe out all visible areas inside the printer and cutter. Also,
thoroughly wipe off any dust which may be on the Ribbon Cartridge. Be
extremely careful not to let any alcohol drip inside the printer's case!

6. Re-install the Ribbon Cartridge, shut the Cutter Door, and shut the printer's Top
Cover.
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E. CLEANING THE PLATEN ROLLER

The Platen Roller rests just underneath the Print head when the printer's Top
Cover is closed. During printing, print media is wrapped tightly around this roller
in order to maintain consistent print registration. 

Periodically clean the printer's Platen Roller if you notice excess dust or debris
accumulation on the roller or if feeding problems or print media jams occur.  Also
perform this procedure if you notice any ink on the Platen Roller.  Use the
following steps to clean this roller.

1. Open the printer's Top Cover by pressing the Cover Release Button.

2. Remove the Ribbon Cartridge from the printer.

3. Locate the Platen Roller. It is the long, black rubber roller in the center of the
printer's interior.

4. Use a Cleaning Pad from the Printer Cleaning Kit or a soft, lint-free cloth 

5. Slightly moistened with isopropyl alcohol to thoroughly wipe the roller clean.
While wiping, use the Cancel button of the Printer controls to rotate the roller.
Be extremely careful not to let any alcohol drip inside the printer's case!

6. After the roller is clean and completely dry, replace the Ribbon Cartridge and
close the printer's cover.

Platten Roller
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F. CLEARING A RIBBON JAM

If the ribbon becomes jammed in the printer's Platen Roller (visible when you open
the printer's Top Cover), use the following procedure to correct the problem.

1. With the printer's Top Cover open, remove the ribbon take-up core (the side
with the used ribbon on it) from the Ribbon Cartridge.

2. Gently pull the ribbon up and out of the printer while pressing and holding
down the printer's On-Line button. This will rotate the Platen Roller backwards
and eject the ribbon while you are pulling upwards.

3. If any ink is visible on the Platen Roller, clean it according to the steps in Part E
of this section.

G. CLEARING A MINOR PRINT MEDIA JAM

If a sheet of print media becomes jammed inside the unit, remove it through the
following steps:

1. Open the printer's Top Cover by pressing the Cover Release Button.

2. Remove the Ribbon Cartridge and, if necessary, the Media Tray Assembly from
the printer.

3. From the Printer controls, press the Cancel button to advance the print media.
Press the On-Line button to reverse the print media. If the print media is
jammed within the cutter, press the cutter's Cancel button to advance the print
media or its Pause button to reverse the print media. Note that the Cutter Door
must be closed and the printer's Top Cover must be open in order for the cutter
buttons to function in this manner. 

4. While pressing either of the Printer buttons, it may also be necessary to gently
pull on the appropriate end of the print media to help clear out the media. If
pressing either of the buttons does not seem to move the print media and it
appears to be stuck, refer to the steps in Part I of this section.

5. Once the jam has been cleared, replace the Print Cartridge and Media Tray
Assembly, and close the Top Cover. 
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H. CLEARING A MAJOR PRINT MEDIA JAM

Although rare, print media can sometimes begin to separate from its backing while
printing.  When this happens, it can occasionally become stuck to the interior
rollers causing the media to jam and halt the print process.  If this happens, do not
attempt to rip the media from the printer.  This will cause the media to tear,
leaving media fragments within the printer.  Instead, use the following procedure
to clear the print media from the printer.

1. Open the printer's Top Cover by pressing the Cover Release Button.

2. Remove the Ribbon Cartridge from the printer.

3. Remove the Print Pressure Bracket in the same manner as when loading a
media roll in the press. 

4. Once the bracket is removed, clear all traces of the jammed media from the
printer. You may need to cut the media to clear it from the press. If necessary,
turn the printer power back ON, and press the Cancel button to rotate and
view all areas of the rollers.

5. When all print media is cleared, reload the media roll as described earlier in
this manual.

6. Replace the Print Cartridge and close the Top Cover.  Reset the processors of
your press by pushing both Cancel/- and Retry/Enter buttons simultaneously.
You are now ready to resend your print job. 

I. REPLACING THE CUTTER BLADE

Your press's cutter uses a tiny razor-sharp blade to kiss-cut its output. Over time,
this blade will eventually begin to grow dull. When this happens, you may notice
one or all of the following symptoms: 

The cut line is rough or jagged as if the media were being ripped instead of
sliced. 
If the cut line has sharp, pointed corners, some of these corners start to lift up
as they are cut.
Excess cutting pressure is required for print media which originally required
far less pressure.
Print media which normally cuts fine, starts to stall the cutter as cut pressure is
increased.

If any of these symptoms begin to consistently occur, replace the Cutter Blade
according to the following steps.

1. Open the Cutter Hood by pulling up on the front of the door's handle.
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2. Locate the black, plastic Cutter Arm which holds the aluminum Blade Holder
in place.

3. Loosen the gold-colored Securing Knob by turning it toward the rear of the
printer.

4. Remove the aluminum Blade Holder.

The cutter blade is razor-sharp and can easily cut you. Be extrememly careful when
removing this blade!

Cutter Arm

Blade Holder

CAUTION!

!
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5. Unscrew and remove the top of the Blade Holder.

6. Tip the base of the holder upside down and remove the blade.

7. Insert the new blade into the base of the holder and replace the holder's screw-
on top.

8. Place the Blade Holder back into the Cutter Arm and retighten the gold-colored
Securing Knob by turning it toward the front of the printer.  Tighten only until
the Blade Holder fits securely within the Cutter Arm.  To verify proper
tightness, try rotating the Blade Holder clockwise within the Cutter Arm.  If it
rotates, the Securing Knob needs to be further tightened.  Do not over-tighten!
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If you have difficulty operating your press, the troubleshooting suggestions in this
section should, in most cases, solve the problem.  If you still have difficulty after
trying these suggestions, call PRIMERA's Technical Support Group at (763)475-
6669.  Customer and technical support representatives are available Monday
through Friday, 8:00 AM to 5:00 PM Central Standard Time.  

You may also leave a message 24-hours a day if you'd like to have a representative
call you back the next business day.  To FAX a question, the Tech Support FAX
number is (763)475-6677.

Technical support and printer driver upgrades can also be obtained by connecting
to PRIMERA's World Wide Web Home Page, http://www.primeratechnology.com.

Control Panel LCD Display
Your press's LCD Display is the best troubleshooting tool at your disposal. It will
identify and report any errors sent from the many sensors used to monitor your
press. This section will list error messages along with descriptions and suggestions
for fixing problems.

RIBBON OUT:

(RIBBON TYPE)
This message indicates the ribbon has stopped moving inside the printer. Most
likely this is because the ribbon has reached the end of the roll. The second line of
the message is followed by the type of ribbon required (i.e. #200 CMY for a #200
Series 3 color Dye-sublimation ribbon. See section XX for a description of ribbon
types. Replace the ribbon and press the Retry button to continue. If a ribbon jam
has caused the error, look at the following section for more information.

Troubleshooting 9
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PRINTER:

RIBBON JAM
This error condition, much like the previous error, indicates the ribbon is unable to
move freely inside the printer portion of the press. If the ribbon is not completely
used, then the most common reason would be that the ribbon is not properly
installed. Remember, unused ribbon always goes to the left and feeds from
underneath the roll; used ribbon comes over the top of the right side of the roll.
Also, the ribbon core that identifies the ribbon to your press must be in the Front
corner of the press as shown below:

The error could also be due to the ribbon breaking and being pulled through the
press with the media. Ribbon breaks can occur if the intensity setting in the printer
driver (section 6-C) is set too high. To clear the error, do the following:

1. Cancel the print job from Windows Spooler by clicking Printer then Purge
Print Documents. 

2. Open the printer cover. 

3. When the printer cover is open, use the Cancel button to force the media/
ribbon to reverse through the press, and use the Retry button to  force the
media/ ribbon forward through the press. If this does not help or if the paper
has also jammed, remove the print pressure bracket as described in section X.X.
This will allow any ribbon or paper to be removed with ease.

Impressa3.qxd  10/22/01  9:30 PM  Page 74



Section 9:  Troubleshooting 75

Digital Label Press 3 User’s Manual

4. If the ribbon is torn, it can be fixed by cutting the torn edge and taping it to the
take up roll. Be careful to line the ribbon up straight when repairing it as to
avoid further jams. 

5. Replace the ribbon and paper.

6. Close the lid of the unit and press both the Cancel and Retry buttons
simultaneously. This will reset the unit. This is very important because the
unit's memory buffer hold's much of the data for a print job. This will clear the
buffer and allow the job to be resent.

7. Press Menu to bring up the PAGE LOAD SEQUENCE as described in the
section on paper loading and press ENTER to run the paper load sequence. 

8. Resend your job.

WRONG RIBBON:

(RIBBON TYPE)
This message will be displayed when the ribbon installed in your press does not
match the ribbon selected in the driver when the job was printed. The second line
of the message will display the type of ribbon selected in the driver. Replace the
ribbon as described in section 4-C, close the cover, and press the Retry button to
continue printing.

OUT OF PAPER:

(PAPER TYPE)
Media rolls are programmed to run exactly 100 prints to avoid the press
accidentally printing when no media is present. Some extra material is on your roll
to allow for waste that occurs during loading. This means that there may be some
material left on the roll when this message is displayed, however, the press will not
be able to print until a new roll of media is installed. The second line of the
message will display the type of media needed to finish the current job (i.e. #200
ABR for #200 Series Dye-sublimation Adhesive Backed Receiver). Do the following
to clear this error:

1. Cancel the print job from the Windows Spooler or Press Print.

2. Replace paper as described in section 4-D.

3. Close the lid of the unit and push both the Cancel and Retry buttons
simultaneously. This will reset the press. This is very important because the
unit's memory buffer holds quite a bit of data. This will clear the buffer.

4. Press Menu to bring up the PAGE LOAD SEQUENCE as described in the
section on paper loading and press ENTER to run the paper load sequence. 

5. Resend your job from Press Print.
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PAPER CORE

ROTATION ERROR
The paper core is located to the left of the media input assembly when loading
media rolls. If the roll is installed properly, it will snap into place with the hub of
the sensor and will rotate that hub as the media is fed through the press. 

First make certain that the media is installed correctly as described in section 4-D.
If the media is installed correctly, make sure the Media Input Assembly Interface
cable is installed correctly as described in section 4-G. Once the problem has been
corrected, press the Retry button to continue printing. 

PRINTER:

PAPER JAM
This error will occur if the press can not internally detect paper movement. It is
rare, but if the media has separated from its backing inside the printer portion of
the press it would cause a paper jam. To clear a jam, do the following:

1. Cancel the print job from Windows Spooler or PressPrint.

2. Open the printer cover and remove the ribbon. 

3. When the printer cover is open, use the Cancel button to force the
media/ribbon to reverse through the press, and use the Retry button to force
the media/ ribbon forward through the press. If this does not help, remove the
print pressure bracket as described in section 4-D. This will allow any ribbon or
paper to be removed with ease.

4. Reload the paper as described in section 4-D.

5. Close the lid of the unit and press both the Cancel and Retry buttons
simultaneously to reset the press. 
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6. Press Menu to bring up the PAGE LOAD SEQUENCE as described in the
section on paper loading and press ENTER to run the paper load sequence. 

7. Resend your job from Press Print.

RIBBON SENSOR 

ERROR
The ribbon sensor detects the different colored panels of the ribbon. This error will
be displayed if the sensor is not able to read the colors of the ribbon correctly. First
make certain the proper ribbon type is installed. If so, make certain that the sensor
connector is slid all the way to the right (as shown above). If not, the press's
processor can not see the information being sent from the ribbon sensor. If the
ribbon and the sensor connector are ok, you will need to calibrate the ribbon
sensor. This is done as follows:

1. Open the Printer Hood.

2. Manually wind the ribbon forward until the start of the ribbon's yellow panel
and the end of the preceding panel (cyan on the #300 CMY resin ribbon or
clear on the #200 CMYO Dye Sublimation ribbon) can be seen on the take up
roll. There should be almost a full panel of yellow ribbon visible inside the
printer. 

3. Close the Printer hood and verify that the printer is properly connected.

4. Press both the Cancel and Retry buttons to reset the press. Make certain the
display reads:

5. Go the printer driver setup window (see section 6-D) and click on the Calibrate
button. The Printer Ribbon Sensor Calibration window appears.

6. Click on the Send button of the Ribbon Calibrate box to download the ribbon
sensor calibration sequence to the press. The press will advance the ribbon
looking at the yellow panel and recording it in memory. Once the ribbon stops,
the calibration is complete. If successful, the display will read:

7. Open the Printer Hood and rewind the ribbon by hand until all of the yellow
panel is on back on the supply roll. The sensor looks for the change to yellow
so the yellow panel should not be visible.
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CUTTER PAPER 

LOADING ERROR
This will occur if the paper is unable to feed into the cutter. The most common
cause would be the paper is not properly installed in the press. If this error occurs,
take the following steps:

1. Cancel the job Windows Spooler or Press Print.

2. Open the Printer Hood. Inspect the press for a media jam. 

3. Open the Cutter Door and inspect the cutter area for debris. Clean the area if
necessary.

4. Remove the ribbon.

5. Remove and reinstall the media according to the instructions on 4-C.

6. Reinstall the ribbon

7. Close the Printer Hood and press both the Cancel and Retry buttons to reset
the press.

8. Resend your print job.

CUTTER: CARRIAGE 

MOTOR STALL
This message will be displayed if the cutter motor is unable to move the blade
back and forth across the page. If this occurs, it is most likely because the cutter
pressure is too great. You can reduce the cutter pressure with out canceling the job.
Simply slide the cutter pressure switch to the left to reduce the pressure setting by
5 (the setting is displayed on the LCD). Press the Retry button on your press's
control panel to attempt to cut again. 
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CUTTER TARGET

ERROR
This message will be displayed if the cutter targets on your page (shown below)
can not be read by your cutter. This happens when the paper is not feeding
centered through the press. If the paper is biased to one side as it travels through
the paper path, the cutter targets may print off of the page, or too far onto the
page. The Center example below illustrates how the cutter targets should appear
when the paper is feeding properly.

To bias the paper, adjust the 3-position Bias Lever on the back of the Media Input
Assembly. If the paper is biased to the left, move the lever one click to the right. If
the paper is biased to the right, move the lever one click to the left. 

The printer does not even begin to print.
Symptoms: Nothing happens or an error message comes up in the Windows application

program.

Make sure that the power cord is plugged in securely on both ends and that the
printer is turned ON. Confirm power is applied. The Control Panel Display
must read PRINTER TEADY CUTTER READY.
Make certain that the printer cable is securely connected and properly installed.
An error message in the software application telling you that the printer is not
responding is usually due to a missing or defective interface cable.

Biased to the left Center Biased to the right

Cutter
Targets

Biased to the left Center Biased to the right
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The print job rasterizes, but the press doesn't print.
Symptoms: Your computer seems to raster the image and send it to the printer but the

printer does not respond.

You may be in need of more hard drive space. As a rule, you should always
maintain at least 2 GB of free space on your hard disk. 
Reset the press by pressing both the Cancel and Retry buttons and try
resending the job once the display reads: 

The LED light on the Control Panel is flashing erratically.
This indicates a data transmission error.  In other words, Press is not properly
receiving the print data.  If such an error occurs, cancel your print job from
Windows Spooler or PressPrint. Push both the Cancel and Retry buttons on the
press to reset the processors. This resets both the press and the computer and you
should then be able to print. You may see communication errors if: 

You have canceled the printer during a print job and the computer still trying
to send data. If so, cancel the print job in the software and resend it.
You have the press connected through a switch box or USB hub. If so, connect
Press directly to your computer. Do not connect Press through a switch box, as
this can interfere with the flow of print data.
You are using the system print spooler of Windows and your printer starts
printing and stops.  You may need to increase your Transmission Retry Value.
To do this, right-click on the Press Label Press icon within the Printers window.
Then select Properties and click on the Details tab. Under Timeout , Settings,
increase the Transmission Retry Value from 45 to 900.
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My prints have blotches or spots in them.
Symptoms: Small spots appear randomly on the print with no ink or different colors of

ink.

Most likely due to dust inside the printer. Review the procedures in Section 8-D for
cleaning the inside of the printer.

This can also be caused by dust accumulation on the ribbon. The print media will
almost never have dust as it is on a roll. Always store print supplies in the original
packaging or in some other suitable dust-free environment.

Check that you have properly loaded print media and a print ribbon according to
the instructions in Section 4. 

Check that you have loaded compatible print supplies according to the
descriptions given in Section 4. Remember, only supplies within the same #200 or
#300-Series can be used with one another.

If you are using too much heat or not enough heat to properly transfer ink, you
may have problems with print quality. Adjust the Intensity control in Press's
printer driver up or down as needed. 

My dye-sublimation prints look jaggy or pixelated.
Symptoms: Prints do not look smooth or continuous, but rather grainy and unclear.

For best photo-realistic output, you should always use high-resolution 24 bit
images. If scanning an image, always scan the image at a 24-bit color setting, at the
same size at which you will be printing, and at 300 dpi. If you stretch or "blow up"
a small or low resolution image, you will always get a pixelated or grainy effect
when printing.

Try selecting the Fine Anti-Aliasing option from the Preferences tab of PressPrint's
Print window. 

This option should be selected only for dye-sublimation prints and causes printed
images to appear more smoothly around the edges.

The cutter is not functioning as it normally does, and/or the quality of the cut line has
degraded.

Symptoms: 

The cut line is rough or jagged as if the media were being ripped instead of sliced. If the
cut line has sharp, pointed corners, some of these corners start to lift up as they are cut.
Excess cutting pressure is required for print media which originally required far less
pressure.
Print media which normally cuts fine, starts to stall the cutter as cut pressure is
increased.

This is most likely due to a dull cutter blade. Check and/or replace the cutter blade
according to Section 8-K.
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The cut line is not centered on the printed object.
If your cut line is not centered on the object and is not skewed you can move the
entire cut by entering custom settings for your cutter offset. To enter the custom
settings for your Press, open the PressPrint software.  Then, click on the Cut menu
and select Cutter Settings. The Primera Cutter window appears.

Enter the custom values noted on the sheet labeled "Cutter Settings" or on the
printer's rear panel label, and select OK.

The Pressure option controls the overall cut pressure applied by Press's cutter.
Once entered, this setting should not need to be changed.  Instead, when adjusting
for the various types of print media, use only the Cutting Pressure slide on the
front of Press.  See Section 3-D for information on when and how to adjust the
Cutting Pressure slide.

The X Offset and Y Offset options fine-tune the position of the overall cut line.  If
these values are slightly inaccurate, the cut line will not appear centered around
the printed image.  The X Offset dictates the position of the cut line along a fixed
horizontal axis and is measured in thousandths of an inch from the left-hand side
of the page to the left-hand edge of the first cut line.  Therefore, increasing the X
Offset moves the overall cut line further away from the left-hand side of the page
and decreasing it moves it closer (Hint: 100 thousandths of an inch equals .1" or
2.54mm).

The Y Offset dictates the position of the cut line along a fixed vertical axis and is
measured in thousandths of an inch from the top of the page to the top edge of the
first cut line.  Therefore, increasing the Y Offset moves the overall cut line down
from the top edge of the page and decreasing it moves it up (Hint: 100 thousandths
of an inch equals .1" or 2.54mm).
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The Blade Offset indicates the distance from the tip of Press's blade to the edge of
the blade shaft.  Since Press will always use the same type of blade, this value
should always remain the same.

Be sure the cutter settings are configured properly according to Section 7-C.
Be sure the blank size within PressPrint is set to the default size of 
11.71" x 17.3".
The cutter is cutting too deeply or is not cutting deeply enough.

Your press's various print media will require unique cutter pressure settings. Use
the Cutting Pressure Slide to adjust the cut pressure accordingly. See Section 3-D
for instructions on properly adjusting the cutting pressure.

My image gets cut off at the top or bottom (or on the side in Landscape mode).
Remember that there is an unprintable area at the top and bottom of all print
media. This is necessary so that the printer can grip the print media while feeding
it back and forth. See Paper Size explanation in Section 6-D for more print area
information. Be sure images fall within this print area and that the Layout/Blank
Size option in PressPrint is set to 11.710" x 17.3".

Areas of my prints are "scrambled" or look like bar codes.
This signifies a data transmission error. This could be caused by a faulty or
substandard printer cable or parallel port. For best results, use the USB to Parallel
cable provided with your press.
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Printing Methods: Thermal Resin and Dye-sublimation

Printing resolution: 300 x 300 DPI

Colors: 16.7 Million

Color Panel Order:

Color: Yellow, Magenta, Cyan, Overlay (if used)

Monochrome: Continuous single color

Printing Speed:

Dye Sublimation: Approximately 6 minutes per page

Resin Thermal (CMY): Approximately 3 minutes per page

Resin Thermal: Approximately 1 minute per page

Paper Feed Method: Friction feed

Paper Loading:

Supply roll capacity: 100 sheets

Output rack capacity: 100 sheets

Media Size at Output: B/A3-Super 12" x 20"

Printing Area: 11.71" x 17.3"

Ink Ribbon:

Dye-sublimation 3-Color: CMYO; 50 prints/ roll

Resin Thermal 3-Color: CMY; 50 prints/ roll

Spot Color: 200 prints/ roll

Technical
Specifications 10
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Printer Driver: Windows 95, 98, 2000, and ME

Interface: Centronics-type parallel (USB to Parellel cable provided)

Dimensions: 56.25" Lx 14.25"H x 20.25" D(143cmL x 36.2cmH x 51.4cmD)

Weight: 105 lbs. (47.63 Kg) 

Temperature:

Operating: 5°C to 35°C

Storage: -20°C to 55°C (5°C to 35°C guaranteed for Ink Ribbon; -5°C
to 45°C for up to one month is normally acceptable but not
guaranteed)

Humidity:

Operating: 20% to 80% (RH non-condensation)

Storage: 15% to 85% (RH non-condensation)

Supply Voltage: 100 VAC/110-120 VAC/220-240 VAC

Supply Frequency: 50/60 Hz

Safety: UL, UL-C, CE (IEC950)

EMC: FCC Class B, CE
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A. INTRODUCTION

Your press is equipped with a standard 8-bit Centronics-type parallel data
communications port.  This is the means by which the printer receives data from
your computer.  This chapter describes the pin assignments, protocol, and signal
specifications for Press's parallel port.

B. CENTRONICS-TYPE PARALLEL INTERFACE

The Centronics-type parallel interface is the most widely used printer interface due
to its simplicity, speed, and standardization throughout the PC industry.  The
printer's parallel interface connector is a standard 36-pin Amp type with two
metal-wire retaining clips and is ECP (Extended Capabilities Port) compatible.  It
mates with a shielded, bi-directional PC to printer parallel cable. If using a parallel
cable other than the one supplied with your printer, always use an I-EEE 1284
parallel cable which is less than 6 feet in length.

Appendix A: A
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Pin assignments are as follows:

TABLE A-1: Parallel Interface Pin Assignments
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Display errors ............................................................................................................................................11, 12
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